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Platform Trading Forex MetaTrader 
 
http://www.belajarforexpro.com memperkenalkan platform trading MetaTrader yang menawarkan 
beberapa fitur canggih yang didesain untuk meningkatkan performance dalam Trading Forex. 
Menggunakan teknologi tinggi, program ini memiliki interface yang simple dan mudah digunakan 
sehingga trader dapat memonitor transaksi yang mereka lakukan serta melakukan analisa menggunakan 
indikator-indikator yang tersedia dan melakukan pengembangan strategy secara lebih efektif. 
 
Meta Trader adalah salah satu platform terbaik di dunia yang dirancang untuk profesional pada 
transaksi Forex & CFD. Saat ini, lebih dari 100 perusahaan broker dan bank-bank di seluruh dunia telah 
memilih Meta Trader untuk mengakomodasi dan memenuhi standar kinerja bisnis yang tinggi. 
 
MetaTrader juga menyediakan fasilitas trading otomatis yang dapat diprogram menggunakan Bahasa 
Pemrograman Meta Quotes Language (MQL)  Menggunakan bahasa ini, anda dapat membuat Expert 
Advisor, Custom Indicators dan Scripts.  Expert Advisor (Forex Robot) dapat menganalisis situasi di 
pasar, membuat keputusan, menempatkan pending order, menutup posisi, dan membuka posisi tanpa 
ada partisipasi trader. 
 

 

 
 
 
 
 
 
 
 

Copyright of http://www.belajarforexpro.com 
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PANDUAN INSTALASI METATRADER 

 
� Setelah melakukan download software trading MetaTrader pada broker yang digunakan, klik 2x 

pada file setup 
 

 
 

� Pilih bahasa yang anda inginkan, lalu klik Next 
� Tick / centang “Yes, I agree with all the terms of this license agreement”, klik Next 
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� Folder instalasi MetaTrader tidak perlu diubah (default), klik Next 
� Program Group tidak perlu diubah (default), klik Next 

 
 
 
 

 
 

 
 

� Mengisi data personal pada instalasi MetaTrader pertama kali & pendaftaran Demo, tick “I agree 
to subscribe to your newsletters”, lalu klik Next 

� Klik Next. (Untuk account Demo, jika server ada lebih dari 1, silahkan klik Scan lalu pilih server 
yang ping timenya semakin kecil) 
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� MetaTrader akan menggenerate Nomer Login dan Password untuk account Demo. Klik Finish 
 

 

Investor adalah password yang dapat digunakan 
login dan melihat trading, tetapi tidak dapat 
melakukan intervensi. Investor password berguna 
untuk menunjukkan performance trading kepada 
orang lain. 
 
Ingat data login number dan password di atas adalah 
untuk Demo Account 
 
 
 

 
� Setelah klik Finish, secara otomatis MetaTrader akan melakukan login ke Demo Account yang baru 

saja dibuat.  
 
� Untuk membuat account Demo lain, silahkan mengulang langkah sebagai berikut : 

 
Klik Tab File => Open An Account atau Alt-F lalu A 
 

 
LOGIN LIVE ACCOUNT 

 
� Bila anda telah memiliki Account Live dan ingin melakukan login. Silahkan melanjutkan dengan 

langkah sebagai berikut : 
 

Klik Tab File => Login atau Alt-F lalu L 
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Untuk login ke Account Live, setelah anda mendapatkan 
Nomer Login dan Password dari Broker, masukkan Nomer 
Login dan Password pada kolom seperti gambar di samping, 
lalu mengganti Server ke Server Real, klik Login 

 
Password MetaTrader merupakan gabungan huruf besar, 
huruf kecil, dan angka, sebaiknya anda Copy Paste agar tidak 
salah.  

 
FUNGSI DARI ICON-ICON METATRADER 

 
Buka Chart Baru (New Chart) 

Window Price / Market Watch (Ctrl-M) * Demo Account (Account Real tidak mencantumkan 
tulisan Demo Account) 

  Window Navigator (Ctrl-N) *        AutoScroll * 
   Window Terminal (Ctrl-T) * GBP/USD 1 Minute 
    Open Order EA Icon Chart : Bar, Candlestick, Line 
 

 
    Membuat trend line  Time Frame 
   Membuat garis horizontal  Strategy Tester   Zoom In/Out Indicators 
  Membuat garis vertikal    Fibonacci Retracement 
Penunjuk harga pada titik tertentu  MetaEditor 
 
* Penting 
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WINDOW UTAMA METATRADER 
 
Window 1 : Market Watch (Ctrl-M)  
Berisi harga sekarang (Bid / Ask), 
High Low harian (daily), dan jam 
server 
  
Window 2 : Navigator (Ctrl-N) 
Berisi List Account (Demo & Live), 
Indicator, Expert Advisor, dan Script 
Untuk login ke salah satu account 
yang ada dalam list silahkan klik 2x 
pada nomer account. 
Untuk attach Expert Advisor atau 
Script pada pair dan chart yang 
sedang aktif silahkan klik 2x pada 
EA atau script yang anda inginkan. 
 

Window 3 : Chart 
Chart dapat dibuka beberapa sekaligus dengan time frame dan pair yang berbeda. (Klik Tab File => 
New Chart atau Klik Alt-F, lalu N). Sebagai contoh [GBPUSD, M1] pada gambar di atas menunjukkan 
chart yang sedang aktif adalah Chart GBP/USD timeframe 1 menit (pada kiri atas chart tampak 
GBPUSD, M1 atau tab GBPUSD,M1 berwarna putih). 
 
Window 4 : Terminal (Ctrl-T) 
Window untuk mengecek Balance, Margin, Free Margin, Margin Level, Open Posisi, Pending Order, 
History Transaksi (trading/deposit / withdrawal), News Ekonomi terbaru, Alert (Alarm jika harga telah 
menyentuh titik tertentu), Mailbox (berita / pengumuman dari Broker), Journal (Kronologis trading). 

MailBox sangatlah penting untuk sering dicek apabila ada perubahan peraturan dari Broker! 
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Window Market Watch  
adalah window yang menunjukkan Harga Sekarang (Bid/Ask), dan High Low. Untuk subscribe 
Harga High dan Low, silahkan klik kanan mouse pada Market Watch, lalu 
pilih High/Low Jam Server (tidak berjalan berarti Server Broker Off atau tak ada koneksi) 

          
 
 

  
 
 
 
 
 Klik 2x di tabel untuk  

melakukan order 
 Window Navigator 

  Account Demo (hijau) 
  Account Real (kuning) 
  List Indicator 
  List Expert Advisor 
  List Script 
 Window Terminal 

Pending dan Open Order Aktif 
History Closed Position/Deposit 
/Withdrawal 
Berita / News Ekonomi Terbaru 
Alert untuk pemberitahuan harga 
telah menyentuh titik tertentu 
Mailbox yang berisi pengumuman 
dari Broker (Penting)  
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SETTING CHART 
 

Penggantian setting yang berhubungan dengan chart 
dapat dilakukan dengan cara : Klik kanan mouse pada 
chart. 
 
Trading :  
New Order (F9) : Open order pada harga market (saat 
ini)  
Bila titik tempat anda klik kanan pada chart lebih tinggi 
dari harga sekarang, akan muncul pilihan Buy Stop dan 
Sell Limit.  
Bila titik tempat anda klik kanan pada chart lebih rendah 
dari harga sekarang, akan muncul pilihan Sell Stop dan 
Buy Limit. 
 
Expert Advisor (EA / Robot / Program Trading) :  
Untuk mengganti properties / setting input Expert 
Advisor atau nonaktifkan (remove) EA yang sedang aktif 

pada chart tersebut.  
 
Ingat, tidak semua EA dapat berjalan bersamaan pada beberapa Chart yang berbeda ! Pastikan anda 
memahami karateristik EA agar tidak terjadi konflik yang dapat mengacaukan kerja EA.  
 
Indicator List (Ctrl-I) :  
List indikator apa saja yang sedang aktif pada chart tersebut 
 
Periodicity :  
Untuk mengganti time frame chart tersebut 
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Template :  
Chart dan setting indicator favorit dapat disave dalam bentuk template, dan dapat diload kapan saja. 
 
Grid :  
Setting untuk menampakkan garis horizontal dan vertikal pada chart tersebut 
 
Volumes :  
Setting untuk menampakkan grafik volume trading pada chart tersebut 
 
Zoom In / Out :  
Setting zoom untuk memperbesar / memperkecil grafik harga pada chart tersebut 
 
Save as picture :  
Save chart dalam file gambar (gif atau bmp) 
 
Print :  
Untuk melakukan print chart tersebut 
 
Properties :  
Setting untuk mengganti warna elemen chart, menunjukkan garis Ask, Open High Low Close (OHLC),  
dll 
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STATUS KONEKSI INTERNET (STATUS BAR) 
 
Status koneksi internet dapat dicek pada grafik sebelah kanan bawah software MetaTrader.  

 
 

� No connection (Grafik merah) menunjukkan bahwa koneksi internet terputus / tidak ada koneksi 
� Invalid account (Grafik merah) menunjukkan nomer login atau password salah. Ataupun account 

tidak ada (dihapus) 
� Warna grafik hijau full menunjukkan koneksi ke datacenter 
� Warna grafik hijau dan merah menunjukkan koneksi langsung ke server MetaTrader (Ctrl-O => 

Server => Hilangkan tick / centang pada “Data Center auto configuration”) 
 
Troubleshooting : 

Bila grafik koneksi telah menunjukkan minimal warna hijau merah atau 
hijau full tetapi pada chart selalu muncul “Waiting for Update” selama 
lebih dari 10 menit, kemungkinan problem ada pada server broker 

yang memisahkan account menjadi 2 jenis yaitu, standard dan micro. 
 
Untuk mengatasi masalah chart yang selalu tidak update, silahkan Open New Chart (buka chart baru) 
dengan cara klik Tab File => New Chart atau Alt-F, lalu N. (Ingat bukan Tab File => Open Deleted, 
tetapi Open New Chart !).  
 

Bila hanya ada sedikit pilihan currency pair yang nampak, sebelum Open New Chart 
silahkan klik kanan mouse pada Window Market Watch => Show All. 
 
Setelah open new chart, ketika diperhatikan akan 

nampak sedikit perbedaan chart yang baru anda buka tersebut 
dengan chart default. Misalnya GBPUSD.,M1 dengan defaultnya 
GBPUSD,M1. (Sebagai contoh perbedaan ada pada tanda titik setelah pair GBPUSD).  
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Jika chart baru sudah ditambahkan dan tetap muncul “Waiting for Update” atau jam server pada 
Window Navigator TIDAK BERGERAK, klik Ctrl-O => Server => Hilangkan tick / centang pada “Data 
Center auto configuration” hingga “Waiting for Update” hilang dan jam server normal kembali.  
 

Setting server yang terbaik dan wajib bagi 
pengguna Expert Advisor adalah selalu 
menggunakan koneksi langsung ke server 
MetaTrader (tanpa melalui datacenter). 
 
Klik Tab Tools => Options => Server. Hilangkan 
tick pada “Data Center auto configuration” 
 
PENTING : 
Setting seperti ini sangat disarankan untuk 
menghindari chart tidak update yang ditandai 
dengan jam server pada Window Market Watch 

tidak bergerak. Hal ini dapat terjadi karena jika ada gangguan koneksi, setting “auto configuration” akan 
melakukan login ke datacenter yang berbeda-beda secara otomatis, padahal data center tersebut belum 
tentu aktif. Sering-seringlah mengecek jam server di Window Market Watch! (Jika chart tidak update 
maka dapat berakibat sangat berbahaya bagi trader yang menggunakan Expert Advisor / Robot) 
 
Koneksi menggunakan DataCenter : 
 

Untuk mengganti Server MetaTrader, silahkan klik grafik koneksi, lalu pilih server 
yang anda inginkan. (Jangan diganti bila tidak perlu !) 
MetaTrader dapat melakukan pencarian server secara otomatis. Klik Rescan 
Servers untuk melakukan hal ini.  
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MENGGANTI PASSWORD METATRADER 
 

� Untuk mengganti password metatrader, klik Tab Tools => Options atau Ctrl-O 
� Pada Tab Server klik Change. Beri dot pada Change Master Password untuk mengganti password 

utama atau dot pada Change Investor (read only) password. Investor password adalah password 
untuk diberikan kepada investor / orang lain agar mereka dapat mengecek account mereka tanpa 
dapat melakukan intervensi (hanya read only password) 

� Current Password isikan password lama yang ingin diganti. 
� New Password isikan password baru. 
� Confirm ketik ulang password baru 

 
 
 

 
 
 
 
 
 
 
 
  
 Password harus minimal 5 karakter, menggunakan kombinasi huruf besar, huruf kecil, atau angka. 

Contoh : Abcde (gabungan huruf besar dan kecil), abc12 (gabungan huruf kecil dan angka),  
ABC12 (gabungan huruf besar dan angka), atau Abc12 (gabungan huruf besar, kecil, dan angka) 
 
Apabila password telah sukses diganti, maka akan muncul keterangan penggantian password telah 
sukses pada Window Terminal => Tab Journal  
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MENAMBAHKAN INDIKATOR TEKNIKAL 
 

Untuk menambahkan indikator 
teknikal, klik Tab Insert => 
Indicator, Lines, Channels, dll 
 
 
 
 
 
 
 
 
 

 
HISTORY TRANSAKSI 

 
Klik Tab Account History lalu pilih Periode History untuk melihat 
history transaksi Trading / Deposit / Withdrawal pada waktu tertentu. 
 
All History : untuk menampilkan semua history transaksi  
Last 3 Months : untuk menampilkan history transaksi 3 bulan terakhir 
yang tersimpan pada server broker  
Last Month : untuk menampilkan history transaksi bulan lalu  
Custom Period : untuk menampilkan history transaksi sesuai range 
waktu yang anda pilih, misalnya hari ini (today), minggu lalu (last 
week), dll 
Save as Report : untuk save history transaksi (dalam format html) 
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Save as Detailed Report : untuk save history transaksi secara mendetail (dalam format html) 
Commissions : untuk menampilkan komisi yang dicharge broker 
Taxes : untuk menampilkan pajak yang dicharge broker 
Comments : untuk menampilkan komentar misalnya pemberitahuan stop out / so (Margin Call), 
komentar dari Expert Advisor, dana tak cukup, dll 
 

MELAKUKAN ORDER PADA METATRADER 
 

Untuk melakukan order 
silahkan klik 2x pada pasangan 
mata uang (pair) dalam 
Window Market Watch 
 
Pair default  dapat diganti jika 
anda ingin mengubah pair 
sewaktu order 
 
 
 

Cara alternatif adalah klik F9 untuk melakukan order pada chart pair yang 
sedang aktif. 
 
Contoh : Saat itu yang sedang aktif adalah chart untuk pair GBP/USD, maka jika 
anda klik F9 defaultnya adalah order untuk pair GBP/USD. Meskipun demikian, 
pair tetap dapat diganti sesuai pair yang anda inginkan pada Window Order. 
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Setting pada Window Order : 
 
Symbol : mata uang / pair yang diorder 
 
Volume : jumlah lot dari order. Contoh : 
1, 10, 0.1, dll (menggunakan titik untuk 
desimal, bukan koma!) 
 
Stop Loss : harga stop loss 
(menggunakan satuan harga, bukan point 
! contoh : 1.4820) 
 

Take Profit : harga take profit (menggunakan satuan harga, bukan point ! contoh : 1.4875) 
 
Comment : Komentar untuk menandai order (tidak harus diisi, bisa dikosongkan) 
 
Type : Tipe dari order, ada 2 type order yang penting, yaitu Instant Execution dan Pending Order: 
 
Instant Execution (default) : Order pada harga market saat itu (Bid 1.4832 / Ask 1.4835). 
Untuk toleransi ketika ada slippage / terjadi selisih antara harga yang didapatkan dengan harga yang 
diorder silahkan tick Enable maximum deviation from quoted price, lalu masukkan jumlah pip toleransi. 
 
Langkah melakukan order pada harga sekarang (Instant Execution):  

1) Klik 2x pada pair yang diinginkan di Window Market Watch atau klik F9,  
2) Isi kolom Volume dengan jumlah lot, gunakan titik untuk desimal (contoh 0.1) 
3) Isi kolom Stop Loss dan Take Profit (tidak harus). 
4) Pilih Type Instan Execution 
5) Tick Enable maximum deviation from quoted price jika perlu 
6) Klik Sell atau Buy (Ingat Buy mendapatkan harga Ask, Sell mendapatkan harga Bid). 
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Pending Order : Order pada harga selain 
harga market saat itu. Sebagai contoh 
harga sekarang 1.4832. Untuk order di 
atas atau di bawah 1.4832, silahkan 
menggunakan Pending Order. 
 
Order Buy di atas harga Ask sekarang 
1.4835.  
Sebagai contoh order Buy pada harga 
1.4850, Pending Order => Buy Stop 
 
 

Order Buy di bawah harga Ask sekarang 1.4835. Sebagai contoh order Buy pada harga 1.4820, Pending 
Order => Buy Limit 

 
Order Sell di atas harga Bid sekarang 1.4832. Sebagai contoh order Sell pada harga 1.4850, Pending 
Order => Sell Limit 

 
Order Sell di bawah harga Bid sekarang 1.4832. Sebagai contoh order Sell pada harga 1.4820, Pending 
Order => Sell Stop 

 
At Price : Harga pending order yang diinginkan. Sebagai contoh bila anda ingin order Buy pada harga 
1.4850, silahkan isi 1.4850 pada at price 

 
Expire : Masa berlaku pending order (tidak harus diisi). Jika anda isi, maka pending order akan 
dibatalkan (cancel) ketika telah expire (kadaluwarsa). 
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Langkah melakukan Pending Order :  
1) Klik 2x pada pair yang diinginkan di Window Market Watch atau klik F9,  
2) Isi kolom Volume dengan jumlah lot, gunakan titik untuk desimal (contoh 0.1) 
3) Isi kolom Stop Loss dan Take Profit (tidak harus). 
4) Pilih Type Pending Order, Pilih Type Pending Order Stop atau Limit 
5) Isi At price dengan harga Pending Order  
6) Isi Expire (jika perlu)  
7) Klik Place 

 
Penting : 
Pada bagian bawah Expiry ada keterangan : “Open price you set must differ from market price by at 
least 10 pips”. Hal ini dapat menjadi acuan bahwa Pending Order, Stop Loss, dan Take Profit harus 
berjarak minimal 10 point dari harga sekarang ! Pesan Error Invalid S/L or T/P adalah dikarenakan 
setting stop loss / take profit yang lebih kecil dari batas minimum yang diperbolehkan oleh broker. 
Setiap broker memiliki peraturan jarak minimal yang berbeda ! 
 
Order Open ataupun Pending Order aktif akan nampak pada Window Terminal dalam Tab Trade. 
Untuk posisi Open aktif akan berada di sebelah atas kolom Balance, Equity, dll.  
Sedangkan Pending Order (Buy Stop, Buy Limit, Sell Stop, atau Sell Limit) dapat dilihat pada bagian 
bawah kolom Balance, Equity, dll. 

 
Open Order 
Balance 
Pending Order 
 

 
Order yang sudah ditutup ataupun Pending Order yang telah dicancel akan nampak pada Window 
Terminal dalam Tab Account History. 
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Profit / Loss adalah total 
untung / rugi selama 
periode yang anda set 
pada setting Account 
History 

 
Pada gambar di atas, order Sell 0.1 lot GBP/USD open pada harga 1.48464 pukul 10.44 waktu server 
dan close pada harga 1.4823 pukul 10.49 pada hari yang sama yaitu 10 Februari 2009   
 
Penjelasan lebih lengkap mengenai cara perhitungan Volume (lot), Perbedaan Tipe order Buy Stop, Sell 
Stop, Buy Limit dan Sell Limit, Cara setting Stop Loss, Take Profit, Trailing Stop, dan dasar trading forex 
lainnya dapat dibaca di http://www.BelajarForexPro.com/tutorialforex (Indonesia) atau 
http://www.BelajarForexPro.com/tutorialforex_en (English) (Penting dan harus dibaca oleh pemula!) 
 

 
MELAKUKAN CLOSING ATAU EDIT ORDER PADA METATRADER 

 
Cara melakukan closing Open Order : 
 
Klik Tab Trade pada Window Terminal, klik kanan mouse pada order yang 
akan diclose, pilih Close Order.  
 
 
 
 
 
Klik kanan mouse pada open order 
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Setelah itu nampak window Order lalu 
klik button Close (kuning).  
 
Apabila harga bergerak cepat sewaktu 
proses closing, akan nampak konfirmasi 
requote. Artinya harga telah berubah 
dan apakah anda ingin close pada harga 
yang baru, jika ya silahkan close, jika 
tidak bisa anda cancel. 
 
Untuk mengurangi requote pada saat 
harga bergerak cepat, silahkan tick 

Enable maximum deviation from quoted price. Lalu set toleransi deviasi dalam pip 
 

Cara melakukan edit Stop Loss / Take Profit Open Order : 
 
Klik Tab Trade pada Window Terminal, klik kanan mouse pada order yang 
akan diclose, pilih Modify or Delete Order.  
 
Ingat untuk order yang sudah open, tidak dapat diedit harga open dan 
jumlah lot, tetapi hanya dapat mengedit level Stop Loss / Take Profit! 
 
 
 
 
 
Klik kanan mouse pada order untuk mengedit 
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Setelah itu nampak window Order. Ganti 
Stop Loss dan atau Take Profit jika perlu, 
lalu klik button Modify (merah). 
 
Pada contoh di samping ada peringatan : 
Stop Loss or Take Profit you set must differ 
from market price by at least 50 pips. 
 
Umumnya sangat jarang broker yang 
memberikan jarak minimal 50 pips. Karena 
itu silahkan mengecek ulang pada broker 

anda. Jika platform broker memiliki tambahan 1 digit di belakang koma (contoh 4 digit di belakang koma 
menjadi 5 digit di belakang koma) berarti jarak minimal 50 pips = 5 pips pada platform normal. 
 
Ilustrasi : Buy pada 1.50000 maka untuk TP 50 point tambahkan 500 atau 1.50500. Tips mudah untuk 
menghitung level TP atau SL adalah dengan memasukkan pada kolom Level. Untuk TP 50 pada platform 
normal, masukkan level 50 points. Untuk platform 5 digit masukkan Level 500 points. Lalu klik Copy as, 
lalu klik Modify (merah). 
 

Cara mengaktifkan Trailing Stop pada Open Order: 
Klik Tab Trade, klik kanan mouse pada Open Order yang ingin anda 
tambahkan Trailing Stop, pilih Trailing Stop, lalu pilih berapa point yang 
anda inginkan Trailing Stop mulai aktif. 
 
Untuk menambahkan jumlah point yang tidak ada dalam pilihan, 
silahkan klik custom lalu set jumlah yang diinginkan. 
 
Ingat fitur trailing stop hanya aktif jika komputer dan internet terhubung 
dengan server. Pastikan komputer dan internet tetap ON. 
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Setting satuan Profit/Loss 
 

 
 
 
 
 
 
 

 
         Profit/Loss total dari open order aktif (dalam $) 

 
Klik kanan mouse pada Window Terminal Tab Trade. Setelah itu 
akan muncul window yang berhubungan dengan order, pilih 
Profit. 
 
As Points : menampilkan profit dalam satuan point.  
As Term Currency : menampilkan profit dalam satuan Mata Uang 
yang ditradingkan 
As Deposit Currency : menampilkan profit dalam satuan Mata 
Uang yang digunakan Deposit 
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Cara melakukan Delete atau Edit Pending Order aktif : 
 

 
Klik Tab Trade pada Window Terminal, klik kanan mouse pada pending order 
yang akan didelete atau diedit 
 
 
 
 
 
 
Klik kanan mouse pada pending order 
 
 

 
 

Delete Pending Order : 
Setelah itu nampak window Order lalu 
klik button Delete (kuning).  
Untuk mengedit, silahkan lanjut ke Edit 
Pending Order di bagian bawah 
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Edit Pending Order : 
Setelah itu nampak window Order lalu 
ganti Price. Level Stop Loss / Take Profit 
juga dapat anda ganti jika perlu, lalu 
klik button Modify (merah).  
 
 
 
 
 
 
 

 
PENTING : 
Data Take Profit, Stop Loss, dan Pending Order tersimpan dalam server Broker, sehingga meskipun 
komputer dan internet OFF (tidak terhubung dengan server), order anda akan tetap tereksekusi secara 
otomatis.  
 
Sedangkan data Trailing Stop tersimpan dalam komputer client (anda), sehingga apabila komputer atau 
internet mengalami gangguan, maka trailing stop tidak berfungsi. Untuk mengatasi hal ini, selalu 
gunakan stop loss sebagai backup dari trailing stop. 
 

PANDUAN INSTALASI EXPERT ADVISOR 
 
Bagi trader yang trading secara otomatis menggunakan Expert Advisor (Robot Forex), sebagai contoh 
http://www.belajarforexpro.com/expertadvisor.php, dapat melakukan langkah-langkah sebagai berikut : 
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� Copy file Expert Advisor (misalnya super_hedging.ex4) ke dalam directory C:\Program 
Files\MetaTrader4\experts (folder yang berwarna merah tidak harus MetaTrader4, tetapi 
tergantung broker) 

 
� Apabila MetaTrader sedang berjalan, silahkan close lalu open kembali MetaTrader 

 
 
 
 
 
 
 
 
 
 
 
 
 
� Klik Tab Navigator, lalu klik tanda [+] untuk melihat list seluruh Expert Advisors. Bila anda telah 

benar memasukkan file super_hedging.ex4, maka akan nampak super_hedging dengan warna 
abu-abu di dalam List Expert Advisors. Jika tidak nampak, maka close MetaTrader, cek ulang 
folder tempat anda mengcopy file Expert Advisor lalu open MetaTrader kembali. 

 
� Klik Ctrl-O => Klik Tab Expert Advisors dan tick pada pilihan seperti gambar di atas. Lalu OK 
 
� Untuk menjalankan Expert Advisor pada pair dan timeframe tertentu. Silahkan highlight Chart 

yang diinginkan, sebagai contoh chart GBPUSD, M1. 
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Chart yang sedang aktif adalah yang berwarna putih 
 
 

 
 
 
� Klik 2x Expert Advisor atau drag EA ke chart yang sedang aktif. Ingat jangan berkali-kali 

melakukan hal ini pada chart yang berbeda kecuali anda paham bahwa beberapa EA dapat 
berjalan bersamaan tanpa menimbulkan konflik 

 
� Setelah melakukan langkah di atas, akan nampak Window sesuai nama Expert Advisor. Klik Tab 

Inputs untuk mengganti setting Expert Advisor, klik 2x pada setting yang ingin diganti lalu klik OK 
untuk menjalankan EA 

 
 

 
 
 
 
 
 
 
 
 
 

 
Load : Untuk load setting Expert Advisor yang telah anda save. Sebagai contoh trader dapat 
melakukan save setting EA khusus untuk News Non Farm Payroll, dll 
Save : Untuk save setting Expert Advisor sesuai preferensi trader 
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Jika EA telah aktif, akan muncul simbol smiley  (orang tersenyum) pada sudut kanan atas 

Chart. Setting yang salah atau kurang akan menampilkan gambar . Button Expert Advisor yang 

tidak aktif akan menampilkan gambar  .  
 
Untuk mengatasi 2 masalah di atas, silahkan klik kanan mouse pada chart tersebut, lalu pilih 
Expert Advisors => Remove.  

Cek ulang setting Expert Advisor pada Ctrl-O => Tab 
Expert Advisor. 

 
 
 
 
Klik 2x Expert Advisor atau drag EA ke chart yang sedang aktif untuk mengaktifkan ulang EA. 
   
 

MENGINSTALL BEBERAPA METATRADER 
 
Anda dapat menginstall lebih dari satu MetaTrader di PC yang sama. Cara ini umumnya digunakan 
trader yang memiliki lebih dari 1 account dengan tujuan untuk menjalankan Robot Forex (Expert 
Advisor) yang berbeda, strategi yang berbeda, ataupun membagi modal dalam beberapa account untuk 
menghindari Margin Call yang bersamaan. (membagi resiko) 
 
Langkah untuk menginstall lebih dari satu MetaTrader : 
 

1) Ulangi langkah instalasi MetaTrader yang telah dijabarkan pada halaman 2, yaitu klik 2x pada file 
setup MetaTrader. Lanjutkan hingga sampai pada langkah pemilihan folder : 
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2) Bedakan Folder MetaTrader yang kedua dengan folder sebelumnya misalnya folder yang lama : 
C:\Program Files\MetaTrader4, ganti menjadi  C:\Program Files\MetaTrader-FCM 

 
3) Bedakan pula Program Group MetaTrader Baru dengan Program Group MetaTrader sebelumnya : 

MetaTrader 4 ganti menjadi MetaTrader FCM 
 

 
TUTORIAL DAN PANDUAN FOREX 

  
� Mendaftar Forex Real Account (Free) : http://www.belajarforexpro.com/broker.php 
� Tutorial Dasar Trading Forex : http://www.belajarforexpro.com/panduanforex (PDF) 
� Tutorial MetaTrader : http://www.belajarforexpro.com/panduanmt (PDF) 
� Tutorial Memulai Trading di MetaTrader : http://www.belajarforexpro.com/tradeforex (PDF) 
� Tutorial Instalasi VPS : http://www.belajarforexpro.com/vps (PDF) 
� Tutorial Pendaftaran Liberty Reserve : http://www.belajarforexpro.com/libertyreserve (PDF) 
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� Trading Forex Otomatis dengan Robot dan menghasilkan uang terus menerus di saat anda 
 tidur, berlibur, dll. http://www.belajarforexpro.com/expertadvisor.php 

� Download Software PDF Reader untuk membaca file PDF : http://get.adobe.com/reader/ 
 
 

RECOMMENDED PARTNERS 
 
� LearnForexPro.com : Learn Forex Like A Pro (english) http://www.learnforexpro.com 
� FCMarket.com : Reliable Forex (Valas) Broker http://www.fcmarket.com 
� ProChanger.com : Exchanger E-Currency Terpercaya, Cepat, Murah http://www.prochanger.com 

 
Untuk pertanyaan dan saran, silahkan email kami : support@belajarforexpro.com 

 
 

-=SELAMAT BERTRADING DAN SEMOGA SUKSES=- 
 


